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Using SAAM II Working with Experimental Inputs 

 
Working with Experimental Inputs 

 
Prerequisites 
 

The prerequisite for this tutorial is having worked through the SAAM II 
introductory tutorial, “Getting Started with SAAM II Compartmental.” 

 
What you will learn in this tutorial 
 
The purpose of this tutorial is to show you how to specify different input formats for your 
experiment in SAAM II. You will learn 
 

• How to specify single and multiple boluses (Part 1) 
• How to specify single and multiple constant infusions (Part 2) 
• How to specify a primed infusion (Part 3) 
• How to specify an input as an equation (Part 4) 

 
Files Required 
 

Study Files: The study file for this tutorial is 
 

study_0_ExpInp.stu 
 

 
This file is included as part of this tutorial. The file study_0_ExpInp.stu is the 
same as study_0.stu that is installed in the SAAM II program folder and referred 
to in the SAAM II User Guide with the exception there are no data in the Data 
window and the parameters have been set to “fixed.” 
 
Remember study_0 is a study file for an experiment lasting 9 days. In this 
tutorial, the time of the experiment may be adjusted so specific points can be 
illustrated. 
 

Data Files:  There are no data files for this tutorial.  
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Introduction 
 
This tutorial focuses on how to use the options in the Exogenous Input dialog box to 
specify different input formats for your experiment in SAAM II. Several input types are 
permitted. The default input is the bolus. Because of their frequency of use, the bolus, the 
constant infusion and the primed constant infusion are predefined. The equation input 
allows the user to specify any input as long as the terms of the equation are recognized by 
SAAM II. 
 
Other ways of specifying the input dosage and other applications of the Exogenous 
Input dialog box are included in the tutorial Experimental Inputs, Advanced. These 
include: 
 

• Specifying the amount of a dose as a constant in the data file. 
• Specifying the dose as an adjustable parameter. 
• Split inputs (an input into more than one compartment) 
• Parametric deconvolution 
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Part 1. The bolus input (single and multiple) 
 
The bolus input is the most common method by which test material or drugs are 
introduced into the system. The part of the tutorial will show you how to specify both the 
single bolus dose, and multiple boluses. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Open the SAAM II Compartmental study file study_0_ExpInpUS. 

 
a. The file study_0_ExpInpUS.stu should appear in the file list; if it does not, 

find the folder where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window 
will appear as shown below: 

 

 
 

3. View the model and the experiment on the model. In the SAAM II Toolbox, click 
Experiment. The model of the experiment will appear on the Drawing Canvas as 
follows: 
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Notice the difference between this model and the experimental model developed 
and used in the Getting Started with Compartmental tutorial. Here there is no 
experimental input, ex1, and the sample circle, s1, is not filled because there are 
no data in the study file. 
 
You may wish to review the Parameters dialog box and the Samples Attributes 
dialog box. The parameters are those from study_0 except they have been fixed 
since this tutorial involves only simulations and no data fitting. The sample 
equation is “s1 = q1/vol”. 
 

4. Create a bolus injection of 100 mg into Compartment q1. 
 

a. In the SAAM II Toolbox, click Input. 
 
b. Click Compartment q1 and then click on the Drawing Canvas. The 

experimental input ex1 will appear associated with the model as shown below: 
 

 
 

c. Double-click ex1 to open the Exogenous Input dialog box. The Exogenous 
Input dialog box will appear as follows: 
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Notice in the Input Type pane, bolus is selected. 
 

d. Enter a bolus injection of 100 mg. 
 

(1) In the Initial Amount box, type “100”. 
 
(2) Click Add. The Exogenous Input dialog box will appear as follows: 
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(3) Click Done. 
 

5. Solve the model and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
 

b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. Be sure 
the List All Variables check box is not selected so s1 is the only option in the 
Variables for Y-Axis pane. 

 
c. Click s1 to add this to the Current Selection pane. The Plot and Table 

Variables dialog box will appear as shown below: 
 

 

Rev. 10/30/05 ExpInpUS-6 2002 - 2005 University of Washington 



Using SAAM II Working with Experimental Inputs 

 
 

d. Click Done. A plot of s1 will appear in semilog mode in the Plot window as 
shown below (if it is not in semilog mode, in the View menu, click Semilog): 

 

 
 

e. Close the Plot window. 
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6. Create multiple bolus injections of 100mg every 12 hours (every half-day). 
 

a. Double-click ex1 to open the Exogenous Input dialog box. 
 
b. Click Delete to remove the original bolus injection. 
 
c. Create the multiple bolus injections. 
 

(1) In the Initial Amount box, type “100”. 
 
(2) In the Event Start box, type “0”. 
 
(3) In the Repeat Every box, type “0.5”. 
 
(4) In the Nr. of Repeats box, type “17”.  
 
(5) Click Add. The Exogenous Input dialog box will appear as shown below: 
 

 
 
(6) Click Done. 
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 The multiple bolus input. In the situation above, the units of the experiment 
are in days. Thus the bolus injection every 12 hours in days will be 0.5. This is 
why 0.5 was entered in the Repeat Every box. Starting at time zero, there will 
be a bolus every 0.5 days for 8.5 days. Thus the number of repeats is 17. 

 
 

d. Solve the model and view the solution. 
 

(1) In this part of the tutorial, it will be useful to increase the resolution of 
your plot. In the Compute Menu, click Computational Settings. Type 
“200” in the Min. Nr. of Calculation Intervals box. Click Done. 

 
(2) In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
 

(3) In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . Your plot of s1 should appear as follows. (If it does not, 
open the Plot and Table Variables dialog box, and click s1 to move it to 
the Current Selection pane.) 

 

 
 

You can see the expected saw-toothed nature of the model predicted 
values following the multiple boluses. 
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(4) Close the Plot window. 
 
7. Create multiple bolus injections three times a day every six hours. 
 
 In what follows, you will simulate an experiment in which three 100 mg doses 

were given daily at 6 hour intervals. The first dose can be assumed to be at 
8:00am, the second at 2:00pm and the third at 8:00pm. There is no dosing 
between 8:00pm and 8:00am. It will be more convenient to work in units of hours 
rather than days, so the first step will be to change the units of the independent 
variable “t” from days to hours. 

 

 Changing the time units of the experiment. In what follows, you will change 
the time units of the experiment from day to hours. You will change “9” days 
to “216” hours. However, the units of the k(i,j) are /day, not /hr. The values of 
all k(i,j) in study_0 are 0.1/day. To convert these to /hr, you need to multiply 
each of the k(i,j) by 1/24. Thus each value for k(i,j) should be 0.042. Since the 
purpose of this tutorial is to illustrate different methods of input, these 
changes to the rate constants will not be made. If you were actually using the 
model on a particular system and changed the units, you would have to make 
these changes. 

 
 

a. On the Set menu, click Experiment Attributes. The Experiment Attributes 
dialog box will open. 

 
b. In the Units box, type “hours”. In the End At box, type “216”. Remember 9 

days equals 216 hours. The Experiment Attributes dialog box will appear as 
follows: 

 

 
 
c. Click Done. 
 
d. Double-click ex1 to open the Exogenous Input dialog box. 
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e. Click Delete to clear the information in the Exogenous Input dialog box. 
 
f. Specify the input of 100 mg every six hours daily. 
 

(1) In the Name box, change “ex1” to “dose”. 
 
(2) In the Reference Name box, type “ThreeDoses”. 
 
(3) In the Units box, type “mg”. 
 
(4) In the Initial Amount box, type “100”. 
 
(5) In the Event Start box, type “0”. 
 
(6) In the Repeat Every box, type “24”. 
 
(7) In the Nr. of Repeats box, type “8”. 
 
(8) Click Add. The Exogenous Input dialog box should appear as follows: 
 

 
 

At this point, you have specified the 100 mg dose daily. You must also 
specify the second dose 6 hours after the first, and then 6 hours after that. 
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(9) The dose does not change. To start the next dosing at 6 hours, in the Event 

Start box, type “6”. To have this repeat every 24 hours, you do not have 
to change the entry in the Repeat Every box or the Nr. of Repeats box. 

 
(10) Click Add. 
 
(11) To start the dosing at 12 hours, in the Event Start box, type “12”.  
 
(12) Click Add. The Experiment Attributes dialog box will appear as 

follows 
 

 
 
(13) Click Done. Your model will appear as follows: 
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 Exogenous input name. The default Name for exogenous inputs is exi for the 
ith input. This is the name that will appear associated with input tool unless 
you change it. In this case, you changed the name from “ex1” to “dose”; 
“dose” will now appear as the name of the input on the drawing canvas (as 
shown in the figure above), and in the list of variables associated with the 
model. The Reference Name, in this case “Three Doses”, is for convenience; 
it is not used by SAAM II. Similarly Units is for convenience. 

 
 
g. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
 
h. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . Your plot of s1 should appear as follows. If it does not, open 
the Plot and Table Variables and select s1. 

 

 
 

Now you see the saw-tooth nature of the model solution changing to reflect 
three inputs (doses) every 12 hours followed by 12 hours with no inputs 
(dosing). You may view the solution in linear mode as well if you wish. 

 
i. Close the Plot window. 
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Quit the SAAM II Compartmental application. Do not save the changes to 
study_0_ExpInp. 
 
 

 The bolus input. The bolus input has been illustrated using the study_0 model. 
This involves input into the compartment from which samples are taken, 
usually plasma. Exactly the same strategy could be applied if you were 
administering the dose, for example, orally. Consider the following 
modification of the study_0 model: 

 

 
 
As shown in the figure above, Compartments q1 and q2 together with the rate 
constants are those from study_0. A third compartment, q3, has been added. 
This model is now a three-compartment model with input into one 
compartment and samples from another compartment. In pharmacokinetics, 
this model is sometimes called the two-compartment model with absorption. 
 
It would be worthwhile for you to create this model, and repeat the different 
input exercise you did above. If, for example, you recreate the 100 mg dose 
every 6 hours daily, you solution, plotted in linear mode (with the Y Axis 
Maximum set at “0.09”), will appear as follows: 
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This shows it is very easy to simulate many different kinds of inputs in the 
bolus format. The example here is very useful in simulating different oral 
dosing regimens. 
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Part 2. The constant infusion input (single and multiple) 
 
The constant infusion input is probably the second most common method by which test 
material or drugs are introduced into the system. The part of the tutorial will show you 
how to specify both a single constant infusion, and multiple infusions. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Open the SAAM II Compartmental study file study_0_ExpInp. 
 

a. The file study_0_ExpInp.stu should appear in the file list; if it does not, find 
the folder where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window 
will appear as shown below: 

 
 

 
 

3. View the model and the experiment on the model. 
 

a. In the SAAM II Toolbox, click Experiment. The model of the experiment 
will appear on the Drawing Canvas as follows: 
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Notice the difference between this model and the experimental model developed 
and used in the Getting Started with Compartmental tutorial. Here there is no 
experimental input, ex1, and the sample circle, s1, is not filled because there are 
no data in the study file. 
 
You may wish to review the Parameters dialog box and the Samples Attributes 
dialog box. The parameters are those from study_0 except they have been fixed 
since this tutorial involves only simulations and no data fitting. The sample 
equation is “s1 = q1/vol”. 
 
b. Change the time of the experiment from 9 days to 96 hours. 
 

It will be more convenient to work in units of hours rather than days which are 
the original units of study_0. The experiment in Study_0 lasted 9 days. In the 
simulations that follow, it is assumed that the experiment lasted 96 hours (4 
days). 
 
(1) On the Set menu, click Experiment Attributes. The Experiment 

Attributes dialog box will open. 
 
(2) In the Units box, type “hours”. In the End At box, type “96”. The 

Experiment Attributes dialog box will appear as follows: 
 

 
 

(3) Click Done. 
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4. Create a constant infusion equal to 500 mg over four hours into Compartment q1. 
 

a. In the SAAM II Toolbox, click Input. 
 
b. Click Compartment q1 and then click on the Drawing Canvas. The 

experimental input ex1 will appear associated with the model as shown below: 
 

 
 

c. Double-click ex1 to open the Exogenous Input dialog box. The Exogenous 
Input dialog box will appear as follows: 

 

 
 

Notice in the Input Type pane, Bolus is selected. 
 

d. Create the infusion. 
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(1) In the Input Type pane, select Infusion. 
 
(2) The total amount of substance infused is 500 mg over 4 hours. Thus the 

infusion rate is 125 mg/hr. In the Constant Rate box, type “125”. 
 
(3) In the Event Start box, type “0”. 
 
(4) In the Event Stop box, type “4”. 
 
(5) Click Add. The Exogenous Input dialog box will appear as follows: 
 

 
 
(6) Click Done. 

 
5. Solve the model and view the solution. 
 

a. It will be useful to increase the resolution of your plot. In the Compute 
Menu, click Computational Settings. Type “200” in the Min. Nr. of 
Calculation Intervals box. Click Done. 

 
b. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
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c. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. Be sure 
the List All Variables check box is not selected so s1 is the only option in the 
Variables for Y-Axis pane. 

 
d. Click s1 to add this to the Current Selection pane. The Plot and Table 

Variables dialog box will appear as shown below: 
 

 
 

e. Click Done. A plot of s1 will appear in semilog mode in the Plot window as 
shown below (if it is not in semilog mode, in the View menu, click Semilog): 
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 Plot resolution. In this simulation, if you had not set the minimum number of 
calculation intervals equal to 200, you would not see the initial rise during the 
infusion. To see this, you can set the minimum number of calculation intervals 
equal to 20 and Resolve. The updated plot will appear as follows: 
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This is why it is important to be aware of the role that plot resolution can play, 
especially in simulation studies, or studies where some data collections times 
are close together and others far apart. 

 
 
f. Close the Plot window. 
 

6. Create a 500 mg infusion for 4 hours daily for an experiment lasting 96 hours. 
 

In this case, you will want to create four infusions lasting 4 hours at a rate of 125 
mg/hr. 
 
a. Double-click ex1 to open the Exogenous Input dialog box. 
 
b. Click Delete to clear the information in the Exogenous Input dialog box. 
 
c. Specify the 125 mg/hr infusion for 4 hours daily for three days.  
 

(1) In the Input Type pane, be sure Infusion is selected. 
 

(2) In the Name box, change “ex1” to “dose”. 
 
(3) In the Reference Name box, type “Three Infusions” 
 
(4) In the Units box, type “mg/hr”. 
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(5) In the Constant Rate box, type “125”. 
 
(6) In the Event Start box, type “0”. 
 
(7) In the Event Stop box, type “4”. 
 
(8) In the Repeat Every box, type “24”. 
 
(9) In the Nr. of Repeats box, type “3”. 
 
(10) Click Add. The Exogenous Input dialog box will appear as follows: 
 

 
 
(11) Click Done. Your model will appear as follows: 
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 Exogenous input name. The default Name for exogenous inputs is exi for the 
ith input. This is the name that will appear associated with input tool unless 
you change it. In this case, you changed the name from “ex1” to “dose”; 
“dose” will now appear as the name of the input on the drawing canvas (as 
shown in the figure above), and in the list of variables associated with the 
model. The Reference Name, in this case “Three Infusions”, is for 
convenience; it is not used by SAAM II. Similarly Units is for convenience. 

 
 
d. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
 
e. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . Your plot of s1 should appear as follows. If it does not, open 
the Plot and Table Variables and select s1. 

 

 
 
f. Close the Plot window. 
 

 
Quit the SAAM II Compartmental application. Do not save the changes to 
study_0_ExpInp. 
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 The constant infusion input. Constant infusion inputs are used in a variety of 
ways in experimental design. In short duration experiments, the infusion can 
last the duration of the experiment. The idea in this design is to design the 
experiment and infusion so that a plateau value is reached. For example in the 
current study file study_0_ExpInp, if you set the duration of the experiment 
equal to 6 hours instead of 96 hours, and set the infusion of 125 mg/hr to last 
the entire six hours, the model would predict the following: 

 

 
 

Obviously at this infusion rate, the experiment had not been carried out long 
enough to achieve a plateau. 
 
Many investigators feel the constant infusion method is superior to the bolus 
injection, but this is not the case. The differential equations represented by the 
model “don’t care” about the input; this is just a term added to one of the 
differential equations. The model “does care” about the nature of the data – 
how many and how precise. Some investigators feel that only the plateau is of 
value, and hence delay in taking the first sample hoping the samples taken are 
only on the plateau. If you do this, the transient nature of how the plateau was 
reached won’t be available, and you will not be able to estimate the rate 
constants in your model. 
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Short constant infusions are often used in place of a bolus in introducing 
material into the system. Such short infusions may last 2 – 5 minutes. These 
constants infusions cannot be modeled as boluses! Your input in your model 
must describe what you did in the laboratory. It can be shown that, if you treat 
a short constant infusion as a bolus, some parameters such as volumes will be 
estimated in error! 
 
Consider the following situation shown in the figure below: 
 

 
 

This is an experiment in which 200 mg of a drug was infused into plasma 
for 5 minutes. The dotted line shows the model solution when the infusion 
input is specified. The solid line shows the model solution when the data 
are fitted assuming a bolus injection of 200 mg. What is different? Using 
the infusion model, the estimated plasma volume is 9.4L while using the 
bolus injection model, the estimated plasma volume is 6.0L, a difference 
of more than 30%. Thus any pharmacokinetic parameter in which volume 
plays a role will be off by this amount! 
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Part 3. The primed constant infusion 
 
The primed constant infusion is sometimes used as a method to introduce test material or 
a drug into the system. This part of the tutorial will illustrate how to specify a primed, 
constant infusion. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Open the SAAM II Compartmental study file study_0_ExpInp. 
 

a. The file study_0_ExpInp.stu should appear in the file list; if it does not, find 
the folder where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window 
will appear as shown below: 

 
 

 
 

3. View the model and the experiment on the model. 
 

a. In the SAAM II Toolbox, click Experiment. The model of the experiment 
will appear on the Drawing Canvas as follows: 
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Notice the difference between this model and the experimental model developed 
and used in the Getting Started with Compartmental tutorial. Here there is no 
experimental input, ex1, and the sample circle, s1, is not filled because there are 
no data in the study file. 
 
You may wish to review the Parameters dialog box and the Samples Attributes 
dialog box. The parameters are those from study_0 except they have been fixed 
since this tutorial involves only simulations and no data fitting. The sample 
equation is “s1 = q1/vol”. 
 
b. Change the time of the experiment from 9 days to 24 hours. 
 

It will be more convenient to work in units of hours rather than days which are 
the original units of study_0. The experiment in Study_0 lasted 9 days. In the 
simulations that follow, it is assumed that the experiment lasted 24 hours. 
 
(1) On the Set menu, click Experiment Attributes. The Experiment 

Attributes dialog box will open. 
 
(2) In the Units box, type “hours”. In the End At box, type “24”. The 

Experiment Attributes dialog box will appear as follows: 
 

 
 

(3) Click Done. 
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4. Create a primed infusion into Compartment q1 with a priming dose of 100 mg 
and a constant infusion of 25 mg/hr for 12 hours. 

 
a. In the SAAM II Toolbox, click Input. 
 
b. Click Compartment q1 and then click on the Drawing Canvas. The 

experimental input ex1 will appear associated with the model as shown below: 
 

 
 

c. Double-click ex1 to open the Exogenous Input dialog box. The Exogenous 
Input dialog box will appear as follows: 

 

 
 

Notice in the Input Type pane, Bolus is selected. 
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d. Create the infusion. 
 

(1) In the Input Type pane, select Primed Infusion. 
 
(2) In the Name box, change “ex1” to “dose”. 

 
(3) In the Reference Name box, type “Primed Infusion” 
 
(4) In the Units box, type “mg/hr”. 
 
(5) In the Initial Amount box, type “100”. 
 
(6) In the Constant Rate box, type “25”. 
 
(7) In the Event Start box, type “0”. 
 
(8) In the Event Stop box, type “12”. 
 
(9) Click Add. The Exogenous Input dialog box will appear as follows: 
 

 
 
(10) Click Done. Your model will appear as follows: 
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 Exogenous input name. The default Name for exogenous inputs is exi for the 
ith input. This is the name that will appear associated with input tool unless 
you change it. In this case, you changed the name from “ex1” to “dose”; 
“dose” will now appear as the name of the input on the drawing canvas (as 
shown in the figure above), and in the list of variables associated with the 
model. The Reference Name, in this case “Primed Infusion”, is for 
convenience; it is not used by SAAM II. Similarly Units is for convenience. 

 
 
5. Solve the model and view the solution. 
 

a. It will be useful to increase the resolution of your plot. In the Compute 
Menu, click Computational Settings. Type “200” in the Min. Nr. of 
Calculation Intervals box. Click Done. 

 
b. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
 

c. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. Be sure 
the List All Variables check box is not selected so s1 is the only option in the 
Variables for Y-Axis pane. 

 
d. Click s1 to add this to the Current Selection pane. The Plot and Table 

Variables dialog box will appear as shown below: 
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e. Click Done. A plot of s1 will appear in semilog mode in the Plot window as 
shown below (if it is not in semilog mode, in the View menu, click Semilog): 

 

 
 
f. Close the Plot window. 
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Quit the SAAM II Compartmental application. Do not save the changes to 
study_0_ExpInp. 

 

 The primed infusion input. The primed infusion works similarly in many ways 
to the constant infusion (see Part 2 of this tutorial). The difference is the 
priming dose. In the example above, a single priming dose and a single 
constant infusion was used. It is clear that, using the capabilities in the 
Exogenous Input dialog box, multiple kinds of inputs can be specified. You 
can specify a single priming dose followed by several constant infusions. You 
can specify multiple priming doses and several constant infusions. In using the 
Exogenous Input dialog box with multiple inputs, it is simply a matter of 
bookkeeping to be sure you specify on your model what you did in the 
laboratory. 

 
 
 

Rev. 10/30/05 ExpInpUS-33 2002 - 2005 University of Washington 



Using SAAM II Working with Experimental Inputs 

Part 4. Equation input 
 
While the most common specification of inputs into a model are the bolus, the constant 
infusion or the primed constant infusion, there are times when you may want to specify 
an input using an equation. 
 
Equation inputs are used in two common ways. One is to specify the equation as a 
constant, the value of which can either be specified in the Parameters dialog box, or read 
in from a data file. The other is to specify a particular equation input. 
 
This tutorial will illustrate how to specify an input that is a sum of exponentials. Any 
equation that is recognized by SAAM II can, however, be used. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Open the SAAM II Compartmental study file study_0_ExpInp. 
 

a. The file study_0_ExpInp.stu should appear in the file list; if it does not, find 
the folder where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window 
will appear as shown below: 
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3. View the model and the experiment on the model. In the SAAM II Toolbox, 
click Experiment. The model of the experiment will appear on the Drawing 
Canvas as follows: 

 

 
 

Notice the difference between this model and the experimental model developed 
and used in the Getting Started with Compartmental tutorial. Here there is no 
experimental input, ex1, and the sample circle, s1, is not filled because there are 
no data in the study file. 
 
You may wish to review the Parameters dialog box and the Samples Attributes 
dialog box. The parameters are those from study_0 except they have been fixed 
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since this tutorial involves only simulations and no data fitting. The sample 
equation is “s1 = q1/vol”. 
 

4. Create an equation input into Compartment q1 where the input equation is 
A*(exp(-a*t)-exp(-b*t)). 

 
a. In the SAAM II Toolbox, click Input. 
 
b. Click Compartment q1 and then click on the Drawing Canvas. The 

experimental input ex1 will appear associated with the model as shown below: 
 

 
 

c. Double-click ex1 to open the Exogenous Input dialog box. The Exogenous 
Input dialog box will appear as follows: 
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Notice in the Input Type pane, Bolus is selected. 
 

d. Create the equation input. 
 

(1) In the Input Type pane, select Equation. 
 
(2) In the Name box, change “ex1” to “input”. 

 
(3) In the Reference Name box, type “Sum of Exponential” 
 
(4) In the Equation box, type “input = A*(exp(-a*t)-exp(-b*t))”. 
 
(5) In the Event Start box, type “0”. 
 
(6) In the Event Stop box, type “9”. 
 
(7) Click Add. The Exogenous Input dialog box will appear as follows: 
 

 
 
(8) Click Done. Your model will appear as follows: 
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 Exogenous input name. The default name for exogenous inputs is exi for the 
ith input. This is the name that will appear associated with input tool unless 
you change it. In this case, you changed the name from “ex1” to “input”; 
“input” will now appear as the name of the input on the drawing canvas, and 
in the list of variables associated with the model. You can also add a reference  
name (in this case “Sum of Exponentials) and specify the units of the input if 
you wish. 

 
When you specify an equation input type, the Equation box will open with 
“ex1”as the default to match the default Exogenous Input name seen in the 
upper left hand corner of the Exogenous Input dialog box. 
 
When you enter the equation, if you had typed  
 

“ex1 = A*(exp(-a*t)-exp(-b*t))” 
 
 you would have received an error when you closed the Exogenous Input 
dialog box. SAAM II will check that the names in the Name box and on the 
left hand side of the equation are the same. For this reason, you entered  
 

“input = A*(exp(-a*t)-exp(-b*t))” 
 
in the Equation box. 

 
 
5. Solve the model and view the solution. 
 

Because of the way in which you specified the equation input, you have 
introduced three new parameters in your model, A, a and b. Before you can solve 
your model, you must provide values for these parameters. 
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a. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open, as 
shown below: 

 

 
 
b. Enter A, a, and b as fixed parameters.  For A, enter “100”; for a, enter “0.05” 

and for b, enter “0.5”. The Parameters dialog box will appear as follows: 
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 Click Done. 

 
c. It will be useful to increase the resolution of your plot. In the Compute 

Menu, click Computational Settings. Type “200” in the Min. Nr. of 
Calculation Intervals box. Click Done. 

 
d. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
 

e. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. Be sure 
the List All Variables check box is not selected so s1 is the only option in the 
Variables for Y-Axis pane. 

 
f. Click s1 to add this to the Current Selection pane. The Plot and Table 

Variables dialog box will appear as shown below: 
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g. Click Done. A plot of s1 will appear in semilog mode in the Plot window as 
shown below (if it is not in semilog mode, in the View menu, click Semilog): 

 

 
 
h. View the input equation. 
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(1) In the Set menu, click Plot/Table Variables. The Plot and Table 

Variables dialog box will open. Be sure the List All Variables check box 
is selected. . The Plot and Table Variables dialog box will appear as 
shown below: 

 

 
 

The variable s1 is in the Current Selection pane because this was your 
last plot. Notice that “input.infusion” appears in the Variables for Y-Axis 
pane. The name “input” is because you changed the name of the input 
from “ex1” to “input” in the Exogenous Input dialog box. 

 
(2) Click input.infusion to move this to the Current Selection pane. 
 
(3) Click Done. The plot of the input equation will appear as follows: 
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(4) Close the Plot window. 

 
 
Quit the SAAM II Compartmental application. Do not save the changes to 
study_0_ExpInp. 
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